
Lattice Semiconductor Corporation - LFE3-70EA-6LFN1156I Datasheet

Welcome to E-XFL.COM

Understanding Embedded - FPGAs (Field
Programmable Gate Array)

Embedded - FPGAs, or Field Programmable Gate Arrays,
are advanced integrated circuits that offer unparalleled
flexibility and performance for digital systems. Unlike
traditional fixed-function logic devices, FPGAs can be
programmed and reprogrammed to execute a wide array
of logical operations, enabling customized functionality
tailored to specific applications. This reprogrammability
allows developers to iterate designs quickly and implement
complex functions without the need for custom hardware.

Applications of Embedded - FPGAs

The versatility of Embedded - FPGAs makes them
indispensable in numerous fields. In telecommunications,
FPGAs are used for high-speed data processing and
network infrastructure. In the automotive industry, they
support advanced driver-assistance systems (ADAS) and
infotainment solutions. Consumer electronics benefit from
FPGAs in devices requiring high performance and
adaptability, such as smart TVs and gaming consoles.
Industrial automation relies on FPGAs for real-time control
and processing in machinery and robotics. Additionally,
FPGAs play a crucial role in aerospace and defense, where
their reliability and ability to handle complex algorithms
are essential.

Common Subcategories of Embedded -
FPGAs

Within the realm of Embedded - FPGAs, several
subcategories address different needs and applications.
General-purpose FPGAs are the most widely used, offering
a balance of performance and flexibility for a broad range
of applications. High-performance FPGAs are designed for
applications requiring exceptional speed and
computational power, such as data centers and high-
frequency trading systems. Low-power FPGAs cater to
battery-operated and portable devices where energy
efficiency is paramount. Lastly, automotive-grade FPGAs
meet the stringent standards of the automotive industry,
ensuring reliability and performance in vehicle systems.

Types of Embedded - FPGAs

Embedded - FPGAs can be classified into several types
based on their architecture and specific capabilities. SRAM-
based FPGAs are prevalent due to their high speed and
ability to support complex designs, making them suitable
for performance-critical applications. Flash-based FPGAs
offer non-volatile storage, retaining their configuration
without power and enabling faster start-up times. Antifuse-
based FPGAs provide a permanent, one-time
programmable solution, ensuring robust security and
reliability for critical systems. Each type of FPGA brings
distinct advantages, making the choice dependent on the
specific needs of the application.
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Product Status Active

Number of LABs/CLBs 8375

Number of Logic Elements/Cells 67000

Total RAM Bits 4526080

Number of I/O 490

Number of Gates -

Voltage - Supply 1.14V ~ 1.26V

Mounting Type Surface Mount

Operating Temperature -40°C ~ 100°C (TJ)

Package / Case 1156-BBGA

Supplier Device Package 1156-FPBGA (35x35)
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Features
 Higher Logic Density for Increased System 

Integration
• 17K to 149K LUTs
• 116 to 586 I/Os

 Embedded SERDES 
• 150 Mbps to 3.2 Gbps for Generic 8b10b, 10-bit 

SERDES, and 8-bit SERDES modes
• Data Rates 230 Mbps to 3.2 Gbps per channel 

for all other protocols
• Up to 16 channels per device: PCI Express, 

SONET/SDH, Ethernet (1GbE, SGMII, XAUI), 
CPRI, SMPTE 3G and Serial RapidIO

 sysDSP™
• Fully cascadable slice architecture
• 12 to 160 slices for high performance multiply 

and accumulate
• Powerful 54-bit ALU operations
• Time Division Multiplexing MAC Sharing
• Rounding and truncation
• Each slice supports

— Half 36x36, two 18x18 or four 9x9 multipliers
— Advanced 18x36 MAC and 18x18 Multiply-

Multiply-Accumulate (MMAC) operations
 Flexible Memory Resources

• Up to 6.85Mbits sysMEM™ Embedded Block 
RAM (EBR) 

• 36K to 303K bits distributed RAM
 sysCLOCK Analog PLLs and DLLs

• Two DLLs and up to ten PLLs per device
 Pre-Engineered Source Synchronous I/O

• DDR registers in I/O cells

• Dedicated read/write levelling functionality
• Dedicated gearing logic
• Source synchronous standards support

— ADC/DAC, 7:1 LVDS, XGMII
— High Speed ADC/DAC devices

• Dedicated DDR/DDR2/DDR3 memory with DQS 
support

• Optional Inter-Symbol Interference (ISI) 
correction on outputs

 Programmable sysI/O™ Buffer Supports 
Wide Range of Interfaces

• On-chip termination
• Optional equalization filter on inputs
• LVTTL and LVCMOS 33/25/18/15/12
• SSTL 33/25/18/15 I, II
• HSTL15 I and HSTL18 I, II
• PCI and Differential HSTL, SSTL
• LVDS, Bus-LVDS, LVPECL, RSDS, MLVDS

 Flexible Device Configuration 
• Dedicated bank for configuration I/Os
• SPI boot flash interface
• Dual-boot images supported
• Slave SPI
• TransFR™ I/O for simple field updates
• Soft Error Detect embedded macro

 System Level Support
• IEEE 1149.1 and IEEE 1532 compliant
• Reveal Logic Analyzer
• ORCAstra FPGA configuration utility
• On-chip oscillator for initialization & general use
• 1.2 V core power supply

Table 1-1. LatticeECP3™ Family Selection Guide
Device ECP3-17 ECP3-35 ECP3-70 ECP3-95 ECP3-150

LUTs (K) 17 33 67 92 149
sysMEM Blocks (18 Kbits) 38 72 240 240 372
Embedded Memory (Kbits) 700 1327 4420 4420 6850
Distributed RAM Bits (Kbits) 36 68 145 188 303
18 x 18 Multipliers 24 64 128 128 320
SERDES (Quad) 1 1 3 3 4
PLLs/DLLs 2 / 2 4 / 2 10 / 2 10 / 2 10 / 2
Packages and SERDES Channels/ I/O Combinations
328 csBGA (10 x 10 mm) 2 / 116
256 ftBGA (17 x 17 mm) 4 / 133 4 / 133   
484 fpBGA (23 x 23 mm) 4 / 222 4 / 295 4 / 295 4 / 295  
672 fpBGA (27 x 27 mm) 4 / 310 8 / 380 8 / 380 8 / 380
1156 fpBGA (35 x 35 mm)   12 / 490 12 / 490 16 / 586

LatticeECP3 Family Data Sheet
Introduction
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Primary Clock Routing 
The purpose of the primary clock routing is to distribute primary clock sources to the destination quadrants of the 
device. A global primary clock is a primary clock that is distributed to all quadrants. The clock routing structure in 
LatticeECP3 devices consists of a network of eight primary clock lines (CLK0 through CLK7) per quadrant. The pri-
mary clocks of each quadrant are generated from muxes located in the center of the device. All the clock sources 
are connected to these muxes. Figure 2-12 shows the clock routing for one quadrant. Each quadrant mux is identi-
cal. If desired, any clock can be routed globally.

Figure 2-12. Per Quadrant Primary Clock Selection

Dynamic Clock Control (DCC)
The DCC (Quadrant Clock Enable/Disable) feature allows internal logic control of the quadrant primary clock net-
work. When a clock network is disabled, all the logic fed by that clock does not toggle, reducing the overall power 
consumption of the device.

Dynamic Clock Select (DCS) 
The DCS is a smart multiplexer function available in the primary clock routing. It switches between two independent 
input clock sources without any glitches or runt pulses. This is achieved regardless of when the select signal is tog-
gled. There are two DCS blocks per quadrant; in total, there are eight DCS blocks per device. The inputs to the 
DCS block come from the center muxes. The output of the DCS is connected to primary clocks CLK6 and CLK7 
(see Figure 2-12).

Figure 2-13 shows the timing waveforms of the default DCS operating mode. The DCS block can be programmed 
to other modes. For more information about the DCS, please see the list of technical documentation at the end of 
this data sheet.

Figure 2-13. DCS Waveforms
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Secondary Clock/Control Sources 
LatticeECP3 devices derive eight secondary clock sources (SC0 through SC7) from six dedicated clock input pads 
and the rest from routing. Figure 2-14 shows the secondary clock sources. All eight secondary clock sources are 
defined as inputs to a per-region mux SC0-SC7. SC0-SC3 are primary for control signals (CE and/or LSR), and 
SC4-SC7 are for the clock.

In an actual implementation, there is some overlap to maximize routability. In addition to SC0-SC3, SC7 is also an 
input to the control signals (LSR or CE). SC0-SC2 are also inputs to clocks along with SC4-SC7.

Figure 2-14. Secondary Clock Sources

Secondary Clock/Control Routing
Global secondary clock is a secondary clock that is distributed to all regions. The purpose of the secondary clock 
routing is to distribute the secondary clock sources to the secondary clock regions. Secondary clocks in the 
LatticeECP3 devices are region-based resources. Certain EBR rows and special vertical routing channels bind the 
secondary clock regions. This special vertical routing channel aligns with either the left edge of the center DSP 
slice in the DSP row or the center of the DSP row. Figure 2-15 shows this special vertical routing channel and the 
20 secondary clock regions for the LatticeECP3 family of devices. All devices in the LatticeECP3 family have eight 
secondary clock resources per region (SC0 to SC7). The same secondary clock routing can be used for control 
signals. 
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Edge Clock Sources
Edge clock resources can be driven from a variety of sources at the same edge. Edge clock resources can be 
driven from adjacent edge clock PIOs, primary clock PIOs, PLLs, DLLs, Slave Delay and clock dividers as shown in 
Figure 2-19.

Figure 2-19. Edge Clock Sources

Edge Clock Routing
LatticeECP3 devices have a number of high-speed edge clocks that are intended for use with the PIOs in the 
implementation of high-speed interfaces. There are six edge clocks per device: two edge clocks on each of the top, 
left, and right edges. Different PLL and DLL outputs are routed to the two muxes on the left and right sides of the 
device. In addition, the CLKINDEL signal (generated from the DLL Slave Delay Line block) is routed to all the edge 
clock muxes on the left and right sides of the device. Figure 2-20 shows the selection muxes for these clocks.
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For further information, please refer to TN1182, LatticeECP3 sysDSP Usage Guide.

MULT DSP Element
This multiplier element implements a multiply with no addition or accumulator nodes. The two operands, AA and 
AB, are multiplied and the result is available at the output. The user can enable the input/output and pipeline regis-
ters. Figure 2-26 shows the MULT sysDSP element.

Figure 2-26. MULT sysDSP Element
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Figure 2-33. Input Register Block for Left, Right and Top Edges

Output Register Block 
The output register block registers signals from the core of the device before they are passed to the sysI/O buffers. 
The blocks on the left and right PIOs contain registers for SDR and full DDR operation. The topside PIO block is the 
same as the left and right sides except it does not support ODDRX2 gearing of output logic. ODDRX2 gearing is 
used in DDR3 memory interfaces.The PIO blocks on the bottom contain the SDR registers but do not support 
generic DDR. 

Figure 2-34 shows the Output Register Block for PIOs on the left and right edges. 

In SDR mode, OPOSA feeds one of the flip-flops that then feeds the output. The flip-flop can be configured as a 
Dtype or latch. In DDR mode, two of the inputs are fed into registers on the positive edge of the clock. At the next 
clock cycle, one of the registered outputs is also latched.

A multiplexer running off the same clock is used to switch the mux between the 11 and 01 inputs that will then feed 
the output.

A gearbox function can be implemented in the output register block that takes four data streams: OPOSA, ONEGA, 
OPOSB and ONEGB. All four data inputs are registered on the positive edge of the system clock and two of them 
are also latched. The data is then output at a high rate using a multiplexer that runs off the DQCLK0 and DQCLK1 
clocks. DQCLK0 and DQCLK1 are used in this case to transfer data from the system clock to the edge clock 
domain. These signals are generated in the DQS Write Control Logic block. See Figure 2-37 for an overview of the 
DQS write control logic.

Please see TN1180, LatticeECP3 High-Speed I/O Interface for more information on this topic.

Further discussion on using the DQS strobe in this module is discussed in the DDR Memory section of this data 
sheet.
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Figure 2-34. Output and Tristate Block for Left and Right Edges

Tristate Register Block 
The tristate register block registers tri-state control signals from the core of the device before they are passed to the 
sysI/O buffers. The block contains a register for SDR operation and an additional register for DDR operation.

In SDR and non-gearing DDR modes, TS input feeds one of the flip-flops that then feeds the output. In DDRX2 
mode, the register TS input is fed into another register that is clocked using the DQCLK0 and DQCLK1 signals. The 
output of this register is used as a tristate control.

ISI Calibration
The setting for Inter-Symbol Interference (ISI) cancellation occurs in the output register block. ISI correction is only 
available in the DDRX2 modes. ISI calibration settings exist once per output register block, so each I/O in a DQS-
12 group may have a different ISI calibration setting.

The ISI block extends output signals at certain times, as a function of recent signal history. So, if the output pattern 
consists of a long strings of 0's to long strings of 1's, there are no delays on output signals. However, if there are 
quick, successive transitions from 010, the block will stretch out the binary 1. This is because the long trail of 0's will 
cause these symbols to interfere with the logic 1. Likewise, if there are quick, successive transitions from 101, the 
block will stretch out the binary 0. This block is controlled by a 3-bit delay control that can be set in the DQS control 
logic block. 

For more information about this topic, please see the list of technical documentation at the end of this data sheet.
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DC Electrical Characteristics
Over Recommended Operating Conditions

Symbol Parameter Condition Min. Typ. Max. Units

IIL, IIH
1, 4 Input or I/O Low Leakage 0  VIN  (VCCIO - 0.2 V) — — 10 µA

IIH
1, 3 Input or I/O High Leakage (VCCIO - 0.2 V) < VIN  3.6 V — — 150 µA

IPU I/O Active Pull-up Current 0  VIN  0.7 VCCIO –30 — –210 µA

IPD I/O Active Pull-down Current VIL (MAX)  VIN  VCCIO 30 — 210 µA

IBHLS Bus Hold Low Sustaining Current VIN = VIL (MAX) 30 — — µA

IBHHS Bus Hold High Sustaining Current VIN = 0.7 VCCIO –30 — — µA

IBHLO Bus Hold Low Overdrive Current 0  VIN  VCCIO — — 210 µA

IBHHO Bus Hold High Overdrive Current 0  VIN  VCCIO — — –210 µA

VBHT Bus Hold Trip Points 0  VIN  VIH (MAX) VIL (MAX) — VIH (MIN) V

C1 I/O Capacitance2 VCCIO = 3.3 V, 2.5 V, 1.8 V, 1.5 V, 1.2 V, 
VCC = 1.2 V, VIO = 0 to VIH (MAX) 

— 5 8 pf

C2 Dedicated Input Capacitance2 VCCIO = 3.3 V, 2.5 V, 1.8 V, 1.5 V, 1.2 V, 
VCC = 1.2 V, VIO = 0 to VIH (MAX) 

— 5 7 pf

1. Input or I/O leakage current is measured with the pin configured as an input or as an I/O with the output driver tri-stated. It is not measured 
with the output driver active. Bus maintenance circuits are disabled. 

2. TA 25 oC, f = 1.0 MHz.
3. Applicable to general purpose I/Os in top and bottom banks.
4. When used as VREF, maximum leakage= 25 µA.
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LatticeECP3 External Switching Characteristics 1, 2, 3, 13

Over Recommended Commercial Operating Conditions

Parameter Description Device

–8 –7 –6

UnitsMin. Max. Min. Max. Min. Max.

Clocks

Primary Clock6 

fMAX_PRI Frequency for Primary Clock Tree ECP3-150EA — 500 — 420 — 375 MHz

tW_PRI
Clock Pulse Width for Primary 
Clock ECP3-150EA 0.8 — 0.9 — 1.0 — ns

tSKEW_PRI
Primary Clock Skew Within a 
Device ECP3-150EA — 300 — 330 — 360 ps

tSKEW_PRIB Primary Clock Skew Within a Bank ECP3-150EA — 250 — 280 — 300 ps

fMAX_PRI Frequency for Primary Clock Tree ECP3-70EA/95EA — 500 — 420 — 375 MHz

tW_PRI Pulse Width for Primary Clock ECP3-70EA/95EA 0.8 — 0.9 — 1.0 — ns

tSKEW_PRI
Primary Clock Skew Within a 
Device ECP3-70EA/95EA — 360 — 370 — 380 ps

tSKEW_PRIB Primary Clock Skew Within a Bank ECP3-70EA/95EA — 310 — 320 — 330 ps

fMAX_PRI Frequency for Primary Clock Tree ECP3-35EA — 500 — 420 — 375 MHz

tW_PRI Pulse Width for Primary Clock ECP3-35EA 0. 8 — 0.9  — 1.0 — ns

tSKEW_PRI 
Primary Clock Skew Within a 
Device ECP3-35EA — 300 — 330 — 360 ps

tSKEW_PRIB Primary Clock Skew Within a Bank ECP3-35EA — 250 — 280 — 300 ps

fMAX_PRI Frequency for Primary Clock Tree ECP3-17EA — 500 — 420 — 375 MHz

tW_PRI Pulse Width for Primary Clock ECP3-17EA 0. 8 — 0.9  — 1.0 — ns

tSKEW_PRI
Primary Clock Skew Within a 
Device ECP3-17EA — 310 — 340 — 370 ps

tSKEW_PRIB Primary Clock Skew Within a Bank ECP3-17EA — 220 — 230 — 240 ps

Edge Clock6

fMAX_EDGE Frequency for Edge Clock ECP3-150EA — 500 — 420 — 375 MHz

tW_EDGE Clock Pulse Width for Edge Clock ECP3-150EA 0.9 — 1.0 — 1.2 — ns

tSKEW_EDGE_DQS
Edge Clock Skew Within an Edge 
of the Device ECP3-150EA — 200 — 210 — 220 ps

fMAX_EDGE Frequency for Edge Clock ECP3-70EA/95EA — 500 — 420 — 375 MHz

tW_EDGE Clock Pulse Width for Edge Clock ECP3-70EA/95EA 0. 9 — 1.0  — 1.2 — ns

tSKEW_EDGE_DQS
Edge Clock Skew Within an Edge 
of the Device ECP3-70EA/95EA — 200 — 210 — 220 ps

fMAX_EDGE Frequency for Edge Clock ECP3-35EA — 500 — 420 — 375 MHz

tW_EDGE Clock Pulse Width for Edge Clock ECP3-35EA 0. 9 — 1.0  — 1.2 — ns

tSKEW_EDGE_DQS
Edge Clock Skew Within an Edge 
of the Device ECP3-35EA — 200 — 210 — 220 ps

fMAX_EDGE Frequency for Edge Clock ECP3-17EA — 500 — 420 — 375 MHz

tW_EDGE Clock Pulse Width for Edge Clock ECP3-17EA 0. 9 — 1.0  — 1.2 — ns

tSKEW_EDGE_DQS
Edge Clock Skew Within an Edge 
of the Device ECP3-17EA — 200 — 210 — 220 ps

Generic SDR

General I/O Pin Parameters Using Dedicated Clock Input Primary Clock Without PLL2

tCO
Clock to Output - PIO Output 
Register ECP3-150EA — 3.9 — 4.3 — 4.7 ns

tSU
Clock to Data Setup - PIO Input 
Register ECP3-150EA 0.0 — 0.0 — 0.0 — ns

tH
Clock to Data Hold - PIO Input 
Register ECP3-150EA 1.5 — 1.7 — 2.0 — ns

tSU_DEL
Clock to Data Setup - PIO Input 
Register with Data Input Delay ECP3-150EA 1.3 — 1.5 — 1.7 — ns
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Figure 3-6. Generic DDRX1/DDRX2 (With Clock and Data Edges Aligned)

Figure 3-7. DDR/DDR2/DDR3 Parameters
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LatticeECP3 Internal Switching Characteristics1, 2, 5 
Over Recommended Commercial Operating Conditions

Parameter Description

–8 –7 –6

Units.Min. Max. Min. Max. Min. Max.

PFU/PFF Logic Mode Timing

tLUT4_PFU LUT4 delay (A to D inputs to F output) — 0.147 — 0.163 — 0.179 ns

tLUT6_PFU LUT6 delay (A to D inputs to OFX output) — 0.281 — 0.335 — 0.379 ns

tLSR_PFU Set/Reset to output of PFU (Asynchronous) — 0.593 — 0.674 — 0.756 ns

tLSRREC_PFU
Asynchronous Set/Reset recovery time for 
PFU Logic 0.298 0.345 0.391 ns

tSUM_PFU Clock to Mux (M0,M1) Input Setup Time 0.134 — 0.144 — 0.153 — ns

tHM_PFU Clock to Mux (M0,M1) Input Hold Time –0.097 — –0.103 — –0.109 — ns

tSUD_PFU Clock to D input setup time 0.061 — 0.068 — 0.075 — ns

tHD_PFU Clock to D input hold time 0.019 — 0.013 — 0.015 — ns

tCK2Q_PFU 
Clock to Q delay, (D-type Register 
Configuration) — 0.243 — 0.273 — 0.303 ns

PFU Dual Port Memory Mode Timing

tCORAM_PFU Clock to Output (F Port) — 0.710 — 0.803 — 0.897 ns

tSUDATA_PFU Data Setup Time –0.137 — –0.155 — –0.174 — ns

tHDATA_PFU Data Hold Time 0.188 — 0.217 — 0.246 — ns

tSUADDR_PFU Address Setup Time –0.227 — –0.257 — –0.286 — ns

tHADDR_PFU Address Hold Time 0.240 — 0.275 — 0.310 — ns

tSUWREN_PFU Write/Read Enable Setup Time –0.055 — –0.055 — –0.063 — ns

tHWREN_PFU Write/Read Enable Hold Time 0.059 — 0.059 — 0.071 — ns

PIC Timing

PIO Input/Output Buffer Timing

tIN_PIO Input Buffer Delay (LVCMOS25) — 0.423 — 0.466 — 0.508 ns

tOUT_PIO Output Buffer Delay (LVCMOS25) — 1.241 — 1.301 — 1.361 ns

IOLOGIC Input/Output Timing

tSUI_PIO
Input Register Setup Time (Data Before 
Clock) 0.956 — 1.124 — 1.293 — ns

tHI_PIO Input Register Hold Time (Data after Clock) 0.225 — 0.184 — 0.240 — ns

tCOO_PIO Output Register Clock to Output Delay4 - 1.09 - 1.16 - 1.23 ns

tSUCE_PIO Input Register Clock Enable Setup Time 0.220 — 0.185 — 0.150 — ns

tHCE_PIO Input Register Clock Enable Hold Time –0.085 — –0.072 — –0.058 — ns

tSULSR_PIO Set/Reset Setup Time 0.117 — 0.103 — 0.088 — ns

tHLSR_PIO Set/Reset Hold Time –0.107 — –0.094 — –0.081 — ns

EBR Timing

tCO_EBR Clock (Read) to output from Address or Data — 2.78 — 2.89 — 2.99 ns

tCOO_EBR
Clock (Write) to output from EBR output 
Register — 0.31 — 0.32 — 0.33 ns

tSUDATA_EBR Setup Data to EBR Memory –0.218 — –0.227 — –0.237 — ns

tHDATA_EBR Hold Data to EBR Memory 0.249 — 0.257 — 0.265 — ns

tSUADDR_EBR Setup Address to EBR Memory –0.071 — –0.070 — –0.068 — ns

tHADDR_EBR Hold Address to EBR Memory 0.118 — 0.098 — 0.077 — ns

tSUWREN_EBR Setup Write/Read Enable to EBR Memory –0.107 — –0.106 — –0.106 — ns
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LatticeECP3 sysCONFIG Port Timing Specifications 
Over Recommended Operating Conditions

Parameter Description Min. Max. Units

POR, Configuration Initialization, and Wakeup

tICFG

Time from the Application of VCC, VCCAUX or VCCIO8* (Whichever 
is the Last to Cross the POR Trip Point) to the Rising Edge of 
INITN

Master mode — 23 ms

Slave mode — 6 ms

tVMC Time from tICFG to the Valid Master MCLK — 5 µs

tPRGM PROGRAMN Low Time to Start Configuration 25 — ns

tPRGMRJ PROGRAMN Pin Pulse Rejection — 10 ns

tDPPINIT Delay Time from PROGRAMN Low to INITN Low — 37 ns

tDPPDONE Delay Time from PROGRAMN Low to DONE Low — 37 ns

tDINIT
1 PROGRAMN High to INITN High Delay — 1 ms

tMWC Additional Wake Master Clock Signals After DONE Pin is High 100 500 cycles

tCZ MCLK From Active To Low To High-Z — 300 ns

tIODISS User I/O Disable from PROGRAMN Low — 100 ns

tIOENSS User I/O Enabled Time from CCLK Edge During Wake-up Sequence — 100 ns

All Configuration Modes

tSUCDI Data Setup Time to CCLK/MCLK 5 — ns

tHCDI Data Hold Time to CCLK/MCLK 1 — ns

tCODO CCLK/MCLK to DOUT in Flowthrough Mode -0.2 12 ns

Slave Serial

tSSCH CCLK Minimum High Pulse 5 — ns

tSSCL CCLK Minimum Low Pulse 5 — ns

fCCLK CCLK Frequency
Without encryption — 33 MHz

With encryption — 20 MHz

Master and Slave Parallel

tSUCS CSN[1:0] Setup Time to CCLK/MCLK 7 — ns

tHCS CSN[1:0] Hold Time to CCLK/MCLK 1 — ns

tSUWD WRITEN Setup Time to CCLK/MCLK 7 — ns

tHWD WRITEN Hold Time to CCLK/MCLK 1 — ns

tDCB CCLK/MCLK to BUSY Delay Time — 12 ns

tCORD CCLK to Out for Read Data — 12 ns

tBSCH CCLK Minimum High Pulse 6 — ns

tBSCL CCLK Minimum Low Pulse 6 — ns

tBSCYC Byte Slave Cycle Time 30 — ns

fCCLK CCLK/MCLK Frequency
Without encryption — 33 MHz

With encryption — 20 MHz

Master and Slave SPI

tCFGX INITN High to MCLK Low — 80 ns

tCSSPI INITN High to CSSPIN Low 0.2 2 µs

tSOCDO MCLK Low to Output Valid — 15 ns

tCSPID CSSPIN[0:1] Low to First MCLK Edge Setup Time 0.3 µs

fCCLK CCLK Frequency
Without encryption — 33 MHz

With encryption — 20 MHz

tSSCH CCLK Minimum High Pulse 5 — ns
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Figure 3-20. sysCONFIG Parallel Port Read Cycle

tSSCL CCLK Minimum Low Pulse 5 — ns

tHLCH HOLDN Low Setup Time (Relative to CCLK) 5 — ns

tCHHH HOLDN Low Hold Time (Relative to CCLK) 5 — ns

Master and Slave SPI (Continued)

tCHHL HOLDN High Hold Time (Relative to CCLK) 5 — ns

tHHCH HOLDN High Setup Time (Relative to CCLK) 5 — ns

tHLQZ HOLDN to Output High-Z — 9 ns

tHHQX HOLDN to Output Low-Z — 9 ns

1. Re-toggling the PROGRAMN pin is not permitted until the INITN pin is high. Avoid consecutive toggling of the PROGRAMN.

Parameter Min. Max. Units

Master Clock Frequency Selected value - 15% Selected value + 15% MHz

Duty Cycle 40 60 %

LatticeECP3 sysCONFIG Port Timing Specifications (Continued)
Over Recommended Operating Conditions

Parameter Description Min. Max. Units

CCLK

CS1N

CSN

WRITEN

BUSY

D[0:7]

tSUCS tHCS

tSUWD

tCORD

tDCB

tHWD

tBSCYC

tBSCH

tBSCL

Byte 0 Byte 1 Byte 2 Byte n*

*n = last byte of read cycle.
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sysI/O Differential Electrical Characteristics
Transition Reduced LVDS (TRLVDS DC Specification)

Over Recommended Operating Conditions

Mini LVDS
Over Recommended Operating Conditions

Symbol Description Min. Nom. Max. Units

VCCO Driver supply voltage (+/– 5%) 3.14 3.3 3.47 V

VID Input differential voltage 150 — 1200 mV

VICM Input common mode voltage 3 — 3.265 V

VCCO Termination supply voltage 3.14 3.3 3.47 V

RT Termination resistance (off-chip) 45 50 55 Ohms

Note: LatticeECP3 only supports the TRLVDS receiver.

Parameter Symbol Description Min. Typ. Max. Units

ZO Single-ended PCB trace impedance 30 50 75 Ohms

RT Differential termination resistance 50 100 150 Ohms

VOD Output voltage, differential, |VOP - VOM| 300 — 600 mV

VOS Output voltage, common mode, |VOP + VOM|/2 1 1.2 1.4 V

VOD Change in VOD, between H and L — — 50 mV

VID Change in VOS, between H and L — — 50 mV

VTHD Input voltage, differential, |VINP - VINM| 200 — 600 mV

VCM Input voltage, common mode, |VINP + VINM|/2 0.3+(VTHD/2) — 2.1-(VTHD/2)

TR, TF Output rise and fall times, 20% to 80% — — 550 ps

TODUTY Output clock duty cycle 40 — 60 %

Note: Data is for 6 mA differential current drive. Other differential driver current options are available.

Current 
Source

VCCO = 3.3 V

Z0

RT RTTransmitter

Receiver
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PICs and DDR Data (DQ) Pins Associated with the DDR Strobe (DQS) Pin
PICs Associated with 

DQS Strobe PIO Within PIC
DDR Strobe (DQS) and 

Data (DQ) Pins

For Left and Right Edges of the Device

P[Edge] [n-3] 
A DQ 

B DQ 

P[Edge] [n-2] 
A DQ 

B DQ 

P[Edge] [n-1] 
A DQ

B DQ 

P[Edge] [n] 
A [Edge]DQSn

B DQ 

P[Edge] [n+1] 
A DQ 

B DQ 

P[Edge] [n+2] 
A DQ 

B DQ 

For Top Edge of the Device

P[Edge] [n-3] 
A DQ 

B DQ 

P[Edge] [n-2] 
A DQ 

B DQ 

P[Edge] [n-1] 
A DQ 

B DQ 

P[Edge] [n] 
A [Edge]DQSn 

B DQ 

P[Edge] [n+1] 
A DQ 

B DQ 

P[Edge] [n+2] 
A DQ 

B DQ 

Note: “n” is a row PIC number. 
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Pin Information Summary (Cont.)
Pin Information Summary ECP3-95EA ECP3-150EA

Pin Type
484 

fpBGA
672 

fpBGA
1156 

fpBGA
672 

fpBGA
1156

fpBGA

General Purpose 
Inputs/Outputs per bank

Bank 0 42 60 86 60 94

Bank 1 36 48 78 48 86

Bank 2 24 34 36 34 58

Bank 3 54 59 86 59 104

Bank 6 63 67 86 67 104

Bank 7 36 48 54 48 76

Bank 8 24 24 24 24 24

General Purpose Inputs per 
Bank

Bank 0 0 0 0 0 0

Bank 1 0 0 0 0 0

Bank 2 4 8 8 8 8

Bank 3 4 12 12 12 12

Bank 6 4 12 12 12 12

Bank 7 4 8 8 8 8

Bank 8 0 0 0 0 0

General Purpose Outputs per 
Bank

Bank 0 0 0 0 0 0

Bank 1 0 0 0 0 0

Bank 2 0 0 0 0 0

Bank 3 0 0 0 0 0

Bank 6 0 0 0 0 0

Bank 7 0 0 0 0 0

Bank 8 0 0 0 0 0

Total Single-Ended User I/O 295 380 490 380 586

VCC 16 32 32 32 32

VCCAUX 8 12 16 12 16

VTT 4 4 8 4 8

VCCA 4 8 16 8 16

VCCPLL 4 4 4 4 4

VCCIO

Bank 0 2 4 4 4 4

Bank 1 2 4 4 4 4

Bank 2 2 4 4 4 4

Bank 3 2 4 4 4 4

Bank 6 2 4 4 4 4

Bank 7 2 4 4 4 4

Bank 8 2 2 2 2 2

VCCJ 1 1 1 1 1

TAP 4 4 4 4 4

GND, GNDIO 98 139 233 139 233

NC 0 0 238 0 116

Reserved1 2 2 2 2 2

SERDES 26 52 78 52 104

Miscellaneous Pins 8 8 8 8 8

Total Bonded Pins 484 672 1156 672 1156
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Package Pinout Information
Package pinout information can be found under “Data Sheets” on the LatticeECP3 product pages on the Lattice 
website at http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3 and in the Diamond or ispLEVER 
software tools. To create pinout information from within ispLEVER Design Planner, select Tools > Spreadsheet 
View. Then select Select File > Export and choose a type of output file. To create a pin information file from within 
Diamond select Tools > Spreadsheet View or Tools >Package View; then, select File > Export and choose a 
type of output file. See Diamond or ispLEVER Help for more information.

Thermal Management 
Thermal management is recommended as part of any sound FPGA design methodology. To assess the thermal 
characteristics of a system, Lattice specifies a maximum allowable junction temperature in all device data sheets. 
Designers must complete a thermal analysis of their specific design to ensure that the device and package do not 
exceed the junction temperature limits. Refer to the Thermal Management document to find the device/package 
specific thermal values.

For Further Information
For further information regarding Thermal Management, refer to the following:

• Thermal Management document

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• Power Calculator tool included with the Diamond and ispLEVER design tools, or as a standalone download from 
www.latticesemi.com/software

http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3.aspx
www.latticesemi.com/dynamic/view_document.cfm?document_id=210
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
http://www.latticesemi.com/products/designsoftware/index.cfm
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Industrial

The following devices may have associated errata. Specific devices with associated errata will be notated with a 
footnote.

Part Number Voltage Grade Power Package1 Pins Temp. LUTs (K) 

LFE3-17EA-6FTN256I 1.2 V –6 STD Lead-Free ftBGA 256 IND 17

LFE3-17EA-7FTN256I 1.2 V –7 STD Lead-Free ftBGA 256 IND 17

LFE3-17EA-8FTN256I 1.2 V –8 STD Lead-Free ftBGA 256 IND 17

LFE3-17EA-6LFTN256I 1.2 V –6 LOW Lead-Free ftBGA 256 IND 17

LFE3-17EA-7LFTN256I 1.2 V –7 LOW Lead-Free ftBGA 256 IND 17

LFE3-17EA-8LFTN256I 1.2 V –8 LOW Lead-Free ftBGA 256 IND 17

LFE3-17EA-6MG328I 1.2 V –6 STD Lead-Free csBGA 328 IND 17

LFE3-17EA-7MG328I 1.2 V –7 STD Lead-Free csBGA 328 IND 17

LFE3-17EA-8MG328I 1.2 V –8 STD Lead-Free csBGA 328 IND 17

LFE3-17EA-6LMG328I 1.2 V –6 LOW Green csBGA 328 IND 17

LFE3-17EA-7LMG328I 1.2 V –7 LOW Green csBGA 328 IND 17

LFE3-17EA-8LMG328I 1.2 V –8 LOW Green csBGA 328 IND 17

LFE3-17EA-6FN484I 1.2 V –6 STD Lead-Free fpBGA 484 IND 17

LFE3-17EA-7FN484I 1.2 V –7 STD Lead-Free fpBGA 484 IND 17

LFE3-17EA-8FN484I 1.2 V –8 STD Lead-Free fpBGA 484 IND 17

LFE3-17EA-6LFN484I 1.2 V –6 LOW Lead-Free fpBGA 484 IND 17

LFE3-17EA-7LFN484I 1.2 V –7 LOW Lead-Free fpBGA 484 IND 17

LFE3-17EA-8LFN484I 1.2 V –8 LOW Lead-Free fpBGA 484 IND 17

1. Green = Halogen free and lead free.

Part Number Voltage Grade1 Power Package Pins Temp. LUTs (K) 

LFE3-35EA-6FTN256I 1.2 V –6 STD Lead-Free ftBGA 256 IND 33

LFE3-35EA-7FTN256I 1.2 V –7 STD Lead-Free ftBGA 256 IND 33

LFE3-35EA-8FTN256I 1.2 V –8 STD Lead-Free ftBGA 256 IND 33

LFE3-35EA-6LFTN256I 1.2 V –6 LOW Lead-Free ftBGA 256 IND 33

LFE3-35EA-7LFTN256I 1.2 V –7 LOW Lead-Free ftBGA 256 IND 33

LFE3-35EA-8LFTN256I 1.2 V –8 LOW Lead-Free ftBGA 256 IND 33

LFE3-35EA-6FN484I 1.2 V –6 STD Lead-Free fpBGA 484 IND 33

LFE3-35EA-7FN484I 1.2 V –7 STD Lead-Free fpBGA 484 IND 33

LFE3-35EA-8FN484I 1.2 V –8 STD Lead-Free fpBGA 484 IND 33

LFE3-35EA-6LFN484I 1.2 V –6 LOW Lead-Free fpBGA 484 IND 33

LFE3-35EA-7LFN484I 1.2 V –7 LOW Lead-Free fpBGA 484 IND 33

LFE3-35EA-8LFN484I 1.2 V –8 LOW Lead-Free fpBGA 484 IND 33

LFE3-35EA-6FN672I 1.2 V –6 STD Lead-Free fpBGA 672 IND 33

LFE3-35EA-7FN672I 1.2 V –7 STD Lead-Free fpBGA 672 IND 33

LFE3-35EA-8FN672I 1.2 V –8 STD Lead-Free fpBGA 672 IND 33

LFE3-35EA-6LFN672I 1.2 V –6 LOW Lead-Free fpBGA 672 IND 33

LFE3-35EA-7LFN672I 1.2 V –7 LOW Lead-Free fpBGA 672 IND 33

LFE3-35EA-8LFN672I 1.2 V –8 LOW Lead-Free fpBGA 672 IND 33

1. For ordering information on -9 speed grade devices, please contact your Lattice Sales Representative.
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LatticeECP3 Maximum I/O Buffer Speed table – Description column, 
references to VCCIO = 3.0V changed to 3.3V.

Updated SERDES External Reference Clock Waveforms.

Transmitter and Receiver Latency Block Diagram – Updated sections of 
the diagram to match descriptions on the SERDES/PCS Latency Break-
down table. 

Pinout Information “Logic Signal Connections” section heading renamed “Package Pinout 
Information”. Software menu selections within this section have been 
updated.

Signal Descriptions table – Updated description for VCCA signal.

April 2012 02.2EA Architecture Updated first paragraph of Output Register Block section.

Updated the information about sysIO buffer pairs below Figure 2-38.

Updated the information relating to migration between devices in the 
Density Shifting section.

DC and Switching
Characteristics

Corrected the Definitions in the sysCLOCK PLL Timing table for tRST.

Ordering Information Updated topside marks with new logos in the Ordering Information sec-
tion.

February 2012 02.1EA All Updated document with new corporate logo.

November 2011 02.0EA Introduction Added information for LatticeECP3-17EA, 328-ball csBGA package.

Architecture Added information for LatticeECP3-17EA, 328-ball csBGA package.

DC and Switching 
Characteristics

Updated LatticeECP3 Supply Current table power numbers.

Typical Building Block Function Performance table, LatticeECP3 Exter-
nal Switching Characteristics table, LatticeECP3 Internal Switching 
Characteristics table and LatticeECP3 Family Timing Adders: Added 
speed grade -9 and updated speed grade -8, -7 and -6 timing numbers. 

Pinout Information Added information for LatticeECP3-17EA, 328-ball csBGA package.

Ordering Information Added information for LatticeECP3-17EA, 328-ball csBGA package.

Added ordering information for low power devices and -9 speed grade 
devices.

July 2011 01.9EA DC and Switching 
Characteristics

Removed ESD Performance table and added reference to LatticeECP3 
Product Family Qualification Summary document.

sysCLOCK PLL TIming table, added footnote 4.

External Reference Clock Specification table – removed reference to 
VREF-CM-AC and removed footnote for VREF-CM-AC.

Pinout Information Pin Information Summary table: Corrected VCCIO Bank8 data for
LatticeECP3-17EA 256-ball ftBGA package and LatticeECP-35EA 256-
ball ftBGA package.

April 2011 01.8EA Architecture Updated Secondary Clock/Control Sources text section.

DC and Switching 
Characteristics

Added data for 150 Mbps to SERDES Power Supply Requirements 
table.

Updated Frequencies in Table 3-6 Serial Output Timing and Levels

Added Data for 150 Mbps to Table 3-7 Channel Output Jitter

Corrected External Switching Characteristics table, Description for 
DDR3 Clock Timing, tJIT.

Corrected Internal Switching Characteristics table, Description for EBR 
Timing, tSUWREN_EBR and tHWREN_EBR.

Added footnote 1 to sysConfig Port Timing Specifications table.

Updated description for RX-CIDs to 150M in Table 3-9 Serial Input Data 
Specifications

Date Version Section Change Summary
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Updated Simplified Channel Block Diagram for SERDES/PCS Block 
diagram.

Updated Device Configuration text section.

Corrected software default value of MCCLK to be 2.5 MHz.

DC and Switching 
Characteristics

Updated VCCOB Min/Max data in Recommended Operating Conditions 
table.

Corrected footnote 2 in sysIO Recommended Operating Conditions 
table.

Added added footnote 7 for tSKEW_PRIB to External Switching Charac-
teristics table. 

Added 2-to-1 Gearing text section and table.

Updated External Reference Clock Specification (refclkp/refclkn) table.

LatticeECP3 sysCONFIG Port Timing Specifications - updated tDINIT 
information.

Added sysCONFIG Port Timing waveform.

Serial Input Data Specifications table, delete Typ data for VRX-DIFF-S.

Added footnote 4 to sysCLOCK PLL Timing table for tPFD.

Added SERDES/PCS Block Latency Breakdown table.

External Reference Clock Specifications table, added footnote 4, add 
symbol name vREF-IN-DIFF.

Added SERDES External Reference Clock Waveforms.

Updated Serial Output Timing and Levels table.

Pin-to-pin performance table, changed "typically 3% slower" to "typically 
slower".

Updated timing information

Updated SERDES minimum frequency.

Added data to the following tables: External Switching Characteristics, 
Internal Switching Characteristics, Family Timing Adders, Maximum I/O 
Buffer Speed, DLL Timing, High Speed Data Transmitter, Channel Out-
put Jitter, Typical Building Block Function Performance, Register-to-
Register Performance, and Power Supply Requirements.

Updated Serial Input Data Specifications table.

Updated Transmit table, Serial Rapid I/O Type 2 Electrical and Timing 
Characteristics section.

Pinout Information Updated Signal Description tables.

Updated Pin Information Summary tables and added footnote 1.

February 2009 01.0 — Initial release.

Date Version Section Change Summary


